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BACKGROUND: 
IDENTIFYING YOUR COMPUTER 

There are two basic types of computers today:  Macs and PCs 
 

 
Partial MacIntosh Program 

1.  Mac (short for MacIntosh - the evolved version of the Apple Computer) was the first 
computer with a graphics user interface (or "GUI", also known as "windows"; programs 
are viewed graphically in individual windows_. Macintosh donated a large amount of 
computers to schools and universities and is the first computer most children use.   
Macs are consistent (their programs work on all versions), easy to set up, have 
excellent graphics capabilities,  read and recognize PC disks (the reverse, 
unfortunately, doesn't hold true) and are generally more expensive than a PC for all  
these reasons.   Macs operate on the principle that "the computer should do all the 
work" and were the first computers to implement "Plug & Play Devices", or the ability 
for the computer to recognize and install the proper hardware.   There is no such thing 
as a Mac clone (or another brand using the MacIntosh operating system) and their 
operating system information is highly protected.   Common Macs today include:  iMac 
and Power Macs.  
 

 
PC Interface (Windows 98) 

 
2.  PC  (short for Personal Computer) used to be called IBM and IBM Clones.  IBM 
released their technical specifications  for other companies to copy (unlike MacIntosh), 
which led to a large amount of cheaper IBM Clone computers on the market.  
Consequently, IBM is no longer the major manufacturer of PCs and new terminology 
had to be used.   "PC" is, of course, a misnomer as Macs are also personal computers 
(but no better terminology has been applied).  PCs include such major brands as: 
Compaq, Dell, Gateway, Hewlett-Packard, IBM, Toshiba and NEC. If you're not sure 
what your computer is, it's probably a PC.  PCs are easily expandable, easier to 
troubleshoot and have arguably more programs (software) written for them.  PCs 
encourage you to add and replace parts inside them (also known as "upgrading"), 
although it's not essential or required.  They're not as easy to set up and use as a Mac,  
but can be configured to your precise specifications.  (Want two hard drives?  Use a 
PC).   PCs give you access to vital system components and assume that you're 
intelligent enough not to throw them away  (it's nice to know they think highly of the 
user).    
 

The rest of this document will focus on PC's. 
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BACKGROUND: 
COMPUTER SIZES 

 

 
 

 

  
 
 
 

  
 

COMPUTER COMPONENTS 
 

1.  Hardware (a.k.a. The Machine): 
Anything you can physically touch (includes: the computer, monitor, keyboard, 
mouse, modem, printer, etc.) 
 
2.  Software (a.k.a. The Programs): 
Any program installed on your computer (includes:  Windows Explorer, Calculator, 
Paint, Wordpad, Microsoft Word, Microsoft Excel, etc.) 
 

We will be discussing the Hardware first. 

1.  Desktop Computers 
 
Bulky, unwieldy and more powerful than a 
laptop.  These reside on a desk and  have a 
separate monitor, keyboard and mouse 
attached. 
 
Computer components at left:   
computer (in red), monitor (in blue), 
keyboard (in green), & mouse (in yellow) 

2.  Laptop Computers 
 

Light, portable and usually  not as 
powerful as a desktop computer.  The 
screen, keyboard and mouse is built 
directly into the computer as well as the 
LCD monitor (liquid crystal display). 
 
Note:  The mouse (in yellow) is built into 
keyboard for space considerations. 
 

3. Dumb Terminals 
 

A dumb terminal has no computer or 
mouse - only a monitor and keyboard.  The 
back of the monitor is connected directly 
to a master computer out of sight of the 
user.   This is what the New York Society 
Library uses for the online catalog. 
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HARDWARE 
THE COMPUTER  

 
 

Once defined as "one who computes," this is now the common term associated with 
the computing device that you connect the monitor, keyboard and mouse to.   
 
The two most important parts of the computer are: 
 

1. The Processor (a.k.a. The CPU, or "Central Processing Unit") 
This is the brains of your computer.  The speed (measured in megahertz, or 
cycles per second, abbreviated MHz)  is determined by the microprocessor chip 
(Intel Pentium is a common type). 
 
2. The Memory 
There are two types of computer memory:  ROM (read-only memory, static 
memory used by the system; don't worry about it) and RAM (random access 
memory, used by you for running programs.  This is cleaned out every time you 
restart your computer) 

 
The computer comes with different drives,  as a means of inputting and exporting data 
to and from your computer.   The common drives are: 
 
• The Hard Drive - this is a permanent, internal storage area inside your computer.  

Information (including the computer operating system) is copied and remains here 
until you physically remove it.  By convention, the computer hard drive is 
associated with the C: drive (a slot on the computer)  

• The Floppy Drive - (a.k.a. the floppy disk drive) enables you to copy information to 
and from your hard drive via an external slot.   Initially, computers had two floppy 
drives (assigned the letters A: and B:) and no hard drive.  The A: drive was used to 
run the operating system (DOS) and the B: drive for specific programs. Nowadays, 
computers generally only have one floppy drive (a 3.5" drive assigned as A:)  Floppy 
disks that you insert in this drive used to come in two sizes:  3.5" square and 5.25" 
square.  The 3 1/2" disks - which store up to 1.44 MB of information) are the ones 
used today.   

• The CD-ROM Drive - (stands for "Compact Disk - Read Only Media", not 
"Memory")  is a somewhat recent development (in conjucntion with the hard drive),   
useful for installing large programs on the hard drive,  viewing interactive 
programs and listening to audio CD-ROM's (just plug headphones into the jack 
near the drive). However, you are unable to save information onto a CD-ROM. 
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THE COMPUTER 

TRANSLATING COMPUTER SPECS 
(or, Translating what the computer nerds are  talking about) 

 
This month (April 2000),  MicroWarehouse is offering the following computer:    a HP 
Brio Minitower, with a 466MHz Celeron processor, 4.36GB hard drive and 32MB RAM 
for $499.    Great price, but what does this all mean?  
 
 
First off, HP stands for Hewlett Packard, a major manufacturer of computers.  The 
"Brio" is one of their models,  but is useful only if you track internal HP hardware 
models (I don't).  Minitower means that it will stand upright instead of being flat and 
wide.   
 
The 466MHz is the speed of the computer and stands for 466 Megahertz (a hertz is one  
cycle per second);  466MHz is a fast speed for a computer.   The New York Society 
Library computers run anywhere from 133 to 350 MHz,  while the fastest computer on 
the market  today runs at 1 GHz, or 1,000 MHz.   Celeron means that it contains an 
Intel Celeron chip (a variation of Pentium), which is a dependable sign (only recently 
have companies other than Intel started manufacturing microchips.  This is one of the 
reasons why there is a  glut of cheap computers on the market).     
 
The 4.36GB hard drive is the storage capacity of the computer. NYSL computers  
range from 810 MB to 7.85 GB hard drives.    A brief discourse on size:  Computer size 
is measured entirely in terms of bytes.   Each character that you type on a keyboard is 
a byte (i.e. the dollar sign $ is one byte).  Bytes, however, are so small as to be 
ridiculous to talk about (you never hear anyone say they have a 4,360,000,000 byte 
drive) 
 

• 1 KB (one kilobyte), or about 1,000 bytes,  is the size of about half the text on 
this page.  Since bytes are so small,  people generally use kilobytes as the 
default size reference.  This entire document, saved in Microsoft Word format, 
takes 756 KB of space. 

• 1 MB (one megabyte) is about 1,000 kilobytes (it's actually 1,024 KB, or 2 to 
the 10th power);  as reference, a 3.5"  floppy disk stores 1.44 megabytes, or a 
hefty 720-page book with no fancy formatting.  

 
• 1 GB (one gigabyte) is about 1,000 megabytes, or 1,000,000 kilobytes.  

 
Onto memory:   32 MB RAM (memory) is pretty poor for a new computer, which means 
that you'll run into problems when running several applications at once (multi-
tasking).   The majority of the NYSL computers have 64 MB RAM; better still is 128 
MB RAM currently on the market.  Memory can always be upgraded (32MB to 64MB, 
and 64MB to 128MB) but it's rather expensive. 
 
Unfortunately,  the speed (466MHz) of the computer won't help if the computer runs 
out of memory (i.e. the computer will freeze if too many programs are run 
simultaneously).     This is why the price for the HP Brio Minitower is (relatively) low. 



INTRODUCTION TO COMPUTERS   Page 6 

  

 
VITAL HARDWARE: 

THE MONITOR 
 

 
 

This is the main output device (or how the computer communicates with you).    
 
There are two video parts:  the monitor and the display adapter.  The monitor is the 
physical screen that sits on your desk.  The display adapter is an expansion card 
(another piece of hardware) inside your computer that tells the computer information 
about the monitor. 
 
Monitors come in two basic styles:  monochrome and color.   The NYSL online catalog 
uses a monochrome monitor (green text on a black background, although there are 
several other variations) while the Children's Room CD-ROM computer (and most PCs) 
uses a color monitor. 
 
The colors displayed on a color monitor can range anywhere from 16 colors (first 
computers) to 256 colors (better) to High Color (16-bit, for Windows 95) to True Color 
(32-bit, for Windows 98), depending on your display adapter.    Screen resolution  
ranges from 640x480 to 800x600 (most common),  to 1024x768 and so on.  The 
resolutions is done in pixels per inch (or tiny individual lights on the monitor).  The 
larger the number, the better the resolution. 
 
Monitors have better resolutions than TV sets, out of necessity; there is too much 
small text that needs to be clearly on a computer that would be blurred on a TV set.  
This is also why monitors are (generally) more expensive than televisions. 
 

A Word about Screensavers: 
If you are planning on keeping your computer and monitor turned on while you're 
away from it for long periods of time (i.e. overnight),  it's a good idea to have a 
screensaver program running.    Screensavers are active programs that save wear and 
tear on your monitor by changing the image on the screen until halted (by hitting any 
key on the keyboard).  They're also fun to watch (see: MOPYfish on the NYSL Kids CD-
ROM computer).  There are several default screensavers in Windows 95 and 98 (found 
in: Start->Settings->Control Panel->Display). 
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HARDWARE: 
THE KEYBOARD 

 

 
 

This is the main input device (how you communicate with the computer).  There are 
four main types of keys on the keyboard: 
 

1.  The Typewriter Keys  are in familiar QWERTY style 
2.  The Function Keys  range from F1 through F10, and are no longer widely 
used (originally used to shorten applications) 
3.  The Arrow Keys ( ) move the onscreen cursor in the arrow direction 
(these are especially useful for the NYSL online catalog).   
4.  The Numeric Keypad is used for fast keying of numbers and can also be 
used as arrow keys (you'll need to toggle Num Lock). 

 
Additionally, the keyboard contains some unique computer keys (used to make things 
easier for you, not harder.  You will not need to use any of these if you don't want to): 
 

USEFUL KEYS: 
 

• CTRL (the Control Key).  Used for program shortcuts (you hold both keys down 
simultaneously).    Useful CTRL sequences are:  CTRL-S to save a file and  
CTRL-Q to quit a file.  Other helpful sequences are:  CTRL-C to copy,  CTRL-X 
to cut, and CTRL-V to paste (for text-editing). 

 
• ALT (the Alternate Key).  Useful in DOS programs to activate the menu bar at 

the top of the screen (Hold down ALT and press the underlined letter). 
 
• ENTER (or RETURN on older models).  Tells the computer that you've finished a 

statement.  Note that text automatically wraps on screen - you do not need to 
hit "ENTER" to move the cursor back to the start of a line. 

 
• BACKSPACE allows you to delete the character preceding the cursor. 
 
• BACKSLASH (\), use for navigating around DOS files (example: C:\Program 

Files\ is the folder "Program Files" on the C:  drive).  The backslash symbolizes 
a folder. 

 
• SLASH (/), used frequently in web addresses (example: 

http://www.nysoclib.org/newbooks/ is the folder "newbooks" on the 
nysoclib.org website).  Similar to the backslash, the slash also symbolizes a 
folder. 

 



INTRODUCTION TO COMPUTERS   Page 8 

  

VITAL HARDWARE: 
THE MOUSE 

 

 
 

This is the secondary input device.   It is theoretically possible (but not easy) to 
maneuver around Windows without a mouse (it is impossible without a keyboard).    
 
A mouse is a hand-held device that controls the movements of a pointer on your 
screen.  When you position the pointer over an object, you can press (click or double-
click) the mouse button to perform different actions on the object.  For example, you 
can double-click to open and work in files, click and drag to move files and click to 
select files.  The pointer usually appears as an arrow, but it can change shape.   
 
You perform most of the tasks on your computer by pointing at an object on your 
screen, and then clicking a mouse button.  To point to an object, move the mouse 
until the tip of the mouse pointer is over the item or area you want.   
 
For now, if your mouse has three buttons, ignore the center one.  The only two 
buttons that you will need to use are the left and right ones. 
 
 

THE FOUR COMMON MOUSE ACTIONS: 
 

Click:  Press and release the left mouse button once 
 
Double-click:  Quickly press and release the left mouse button twice (this needs to be 
done rapidly - if you're too slow, the computer will not open the program) 
 
Right-click:  Press and release the right mouse button once.   
 
Dragging:  To move a screen object, you first position the mouse pointer on the object.  
Next, you "pick up" the object by pressing and holding down the left mouse button. 
While you're still holding down the mouse button, move the mouse pointer to where 
you want to "drop" the object, and then release the mouse button.  You also drag to 
select text, such as works in a document or the name of a file.  To select text, you first 
insert your cursor (a blinking vertical line) where you want to start the selection.  Then 
you hold down the left mouse button, move the mouse pointer to where you want to 
end the selection, and release the mouse button. 
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HARDWARE: 
PRINTER 

The printer is a secondary output device and allows you to make a hard copy of the 
information on the monitor.  The three major printers today are:  dot-matrix,  ink-jet 
and laser.  Dot matrix printers use a grid of dots to create an image and are usually 
quite noisy.  Ink-jet printers shoot the ink (either color or black) onto the paper via 
small nozzles.  Laser printers engrave a temporary image on the internal drum and are 
currently the fastest printers available (they are also the most expensive).  My personal 
favorite is the inkjet printers for ease and flexibility (this document was printed on an 
inkjet printer) 
 

MODEM 
The modem is a communications device for your computer (it stands for "modulator/ 
demodulator", in reference to the sounds it makes).  Modems use an ordinary phone 
line  to link your computer with other computers (i.e. the Internet).  Modems can be 
internal (connect phone line to back of computer) or external (connect phone line to 
modem and modem to computer).  Most modems are 56K, which stands for the speed 
of the modem, not the size (56 kilobytes of data transferred per second).  There will be 
further discussion on modems in the "Introduction to the Internet" class.     
 

SCANNER 
Scanners are a secondary input device for your computer.   Scanners enables you to 
digitize (put into computer form) pictures and text (you need special text-recognition 
software for this feature).  The two common types of scanners are:  flatbed (desktop) 
and hand-held (portable).   
 

SPEAKERS 
Speakers are a secondary output device for your computer.  Combined with a sound 
card (a hardware device installed separately in your system), you can listen to a 
variety of music and sounds stored on your computer.  With a microphone (secondary 
input device),  you can even use your computer (via an internet connection)  as a 
primitive phone. 
 

THE CONTROL PANEL 
 

 
 

To see all the peripheral devices installed on your computer in Windows 95 or 
Windows 98, select START -> Settings -> Control Panels.  Useful icons here are: 
Display, Keyboard, Modem, Mouse and Printers 
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OPERATING SYSTEM:  
DOS:  Disk Operating System 

 

 
 
The first PC operating system was DOS (short for "disk-operating system").  DOS  
relied entirely on typed commands (it was designed before the mouse), and is still in 
effect today (MS-DOS, Microsoft's version,  is the underlying operating system for 
Windows).    I've included DOS here to give you a feel for the structure of the PC. 
 

Basic DOS Commands: 
date     Sets the system date 
time    Sets the system time 
dir  Lists all files  
copy   Copies a file 
cls   Clears the screen 
type    Displays file contents 
rn   Renames a file 

del   Deletes a file 
md    Makes subdirectory 
cd    Changes subdirectory 
..  Moves up one level 
a:  Changes to A: drive 
print  Prints file 
exit   Exits from DOS

 
 

FILE EXTENSIONS: 
 

All PC files are assigned  a three-digit extension following the "." (period).  This tells the 
computer what program was installed and is still used today.  An asterisk (*) is used 
as a wildcard to list all files of a particular type i.e.  C:\dir *.exe will list all executable 
programs in your current folder). 
 

Sample Extensions: 
*.bat   Batch of DOS commands 
*.com  Compiled program  
*.exe  Executable program 
*.sys  System information 
*.ini  Initialization data -system 
*.dll  Dynamic links library file 
 

*.bmp  Bitmap Image 
*.jpg  Photo Image 
*.gif  Graphic Image 
*.txt  Text-based document 
*.doc  MS Word document 
*.xls  MS Excel spreadshee

 
 
 BASIC (Beginners All-Purpose Symbolic Instruction Code) 

 
BASIC is an introductory programming language that uses words such as PRINT, 
INPUT, GOTO, IF and THEN to create new programs.   The most recent version of 
Basic, QBASIC (short for Quick Basic),  comes with  the Windows 95 & 98 CD-ROM  
and needs to be installed to run.  It's found in the folder:  E:\other\oldmsdos\ for 
Win95 or  E:\tools\oldmsdos\ for Win98 and needs to be copied into the 
C:\windows\command\ folder.  One installed, you can start writing programs for 
your computer. 
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OPERATING SYSTEMS: 
Microsoft Windows 3.x 

 
The first upgrade from DOS was a GUI (graphics user interface) that ran over DOS and  
allowed the user to run several programs simultaneously.  Windows 3.x (where "x" 
denoted a different version)  suspiciously resembled the Macintosh operating system 
(not a coincidence) and is still running on some of the older PC's.    
 
Useful Windows programs are: 

• Notepad  A simple text editor 
• Cardfile  Allows user to organize facts on index cards 
• Calculator  A simple calculator 
• Calendar  An online appointment system 
• Clock   Displays a  clock with the current system time 
• Terminal  Provides modem for bulletin boards 

 
 

 
 
 

 
 
 

Microsoft Windows 95 
 

Windows 95 is comprised of: 
• Windows   views files or part of an application 
• Icons           small pictures of files and programs 
• Menus  drops down to display further options 
• Pointer  dragging mouse around desktop 

 
In addition, the Windows environment has a:  

• Desktop   working area on screen (center) 
• Taskbar   informs user of what's being run (bottom) 
• System Tray  special programs on right of  bar (b-right) 
• Start Menu   fast and easy access to software (b-left) 

Microsoft Windows 98 
 

Microsoft Windows 98 has all of the features of Windows 95, 
but with easier access to the Internet and faster 32-bit access 
(this means that the computer can read 32 bits of information  
at a time instead of the 16-bits previously read in Windows 
95).  In practicality, however, there's very little difference 
between the two operating systems 
 
 

Microsoft Windows 2000 
 

This is the most recent version of Microsoft Windows.  It 
diminishes the amount of crashes and conflicts with earlier 
versions, gives better access to files, and has more features 
than Windows 98. It's still in the prelimary stages. 
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GETTING STARTED: 
TURNING ON THE COMPUTER 

 

 
 
 
On desktop computers, the "On" button is usually the largest button on the front of 
the computer.  The smaller, less prominent button is a "Reset" button and only works 
when the computer is on.   On laptop computers, the "On" button is generally located 
on the left-hand side, towards the back of the computer.  This button is somewhat 
depressed and requires you to hold it in for a second or so before releasing it.  When 
you turn your computer on, it runs a check for all the components connected to it (i.e. 
monitor, printer, keyboard, mouse). If there is a disk in the floppy disk drive, it will try 
to boot from this and will give you an error message ("Non-System Disk").  Remove the 
disk and tap any key on the keyboard to resume the boot. 
 

TURNING OFF THE COMPUTER 
You can turn off the computer at any time by pushing the same button that you used 
to turn the computer on.   However,  this will also upset your computer and cause it to 
run a nasty error message when your computer starts up the next time ("You did not 
close Windows properly").    An error-free (better) way  to turn off your computer is by  
clicking the "Start" button in the lower left-hand corner of your screen and selecting 
"Shut Down" from the option menu.  Sometimes the computer will automatically turn 
off, other times it will give you an OK message to turn your computer off.  

 
 

RESTARTING  YOUR COMPUTER 
You will only need to restart your computer when it crashes (i.e. everything on the 
screen locks up and you are unable to open any programs).  The best way to restart 
your computer is by holding down the "CTRL"-"ALT"-"DELETE" buttons 
simultaneously.  If your system isn't entirely frozen, this will bring up a menu of 
currently running programs which you can individually shut down (especially if one of 
them has a "Not Responding" error message next to it).  Barring that, hit "CTRL"-
"ALT"-"DELETE" (also known as Control - Alt - Delete) again to restart the computer.  
 
Otherwise, you can push the second, smaller button on the front  (also known as the 
"panic" button) to restart your computer.  You will get an error message every time you 
restart your computer this way, but it's unavoidable at times. 
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GETTING STARTED: 

(taken from Introducing Windows 95  
& Getting Started with Microsoft Windows 98) 

 
UPPER-RIGHT HAND BUTTONS 

 
 

 
 

RUNNING A  PROGRAM 
You can use the Start button to start any program you want to use, such as your word 
processor program.  Click the Start button, and then point to Programs.   Point to the 
folder, such as Accessories, that contains the program, and then click the program.   A 
new button for the program appears on the taskbar.  To quit a program, click the 
Close button (an "X") in the upper right corner of the window. You can run as many 
programs as you want at the same time.  Windows makes it easy to switch between 
programs or windows - click the taskbar button for the program you want. TIP:  You 
can add a program to the top of the Start menu by dragging its icon onto the Start 
button.  
 

SAVING YOUR WORK 
To save the changes you've made to an existing document or the work you've done into 
a new document, you need to save the document.   To save changes to an existing 
document, on the File menu, click Save.   To save a new document, on the File menu, 
click Save As.  Type a name in the File Name box.  To change the file type, click the 
arrow next to Save as type, and then click the type you want.  To save to a different 
drive and/or folder, open the Save In list, click the drive you want, and then double-
click the folder.  Click Save to complete the operation. 

 
 

COPYING A FILE TO DISK 
Double-click My Computer.  Find the file or folder you want to copy, then click it once.  
On the file menu, point to Send To, and then click the drive where you want to copy 
the file or folder.  You can select multiple items by pressing and holding down the 
CTRL key as you click each item you want, or by clicking Select All on the Edit menu 
to select every item in the window. 
 
 

DELETING A FILE OR FOLDER 
Double-click My Computer.  Find the file or folder you want to delete, and then click it.  
On the File menu, click Delete.  A quicker way to delete a file is to drag it to the 
Recycle Bin on the desktop.  The files you place here aren't removed from your hard 
disk until you "empty" the Recycling Bin. 

These are useful program shortcuts.  The "__" button will move your 
program down to the task bar, freeing up your desktop work space 
(click the appropriate button on the taskbar to restore).  The center 
box button will expand your window to fit the entire screen (or 
reduce your windows to see other programs running).  And the "X" 
button will shut your program down 
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GETTING STARTED: 

(taken from Introducing Windows 95 and  
Getting Started with Microsoft Windows 98) 

 
 
 

SEARCHING FOR FILES OR FOLDERS 
If you don't know where a document or folder is, you can use the find command to 
find and open it  Click the Start button then point to Find.  Click Files or Folders.  
Click the named box, and then type the name of the file or folder you want to find.  To 
specify where to search, click the arrow next to the Look In box, or click Browse.  To 
start the search, click Find Now. 

 
PRINTING A DOCUMENT 

To print a document if the file is open, click File then click Print.   An easy way to print 
is to drag the icon for your document onto a printer desktop shortcut icon.   If you 
have problems printing in Windows, you can use the printing troubleshooter indicated 
in Help.  The troubleshooter helps with problems such as your documents printing 
incorrectly or not at all. 
 
 

COMPUTER FRUSTRATION 
At some stage in this process, you will encounter computer frustration (whether it's 
being unable to find a file you recently saved or having the computer crash 
repeatedly).  This is quite common, as you're learning how to use a complicated device;  
my best advice is to save anything that you're able to, turn the computer off for well 
over a minute (giving time for the hard drive to stop processing information), take a 
deep breath (go out for coffee or a cigarette, if needed), and start again, fresh.  Take 
heart - most computer problems are solved by turning the computer off for a minute 
and rebooting. 
 
 
 

INSTALLING SOFTWARE 
Click the Start button, point to Settings, and then 
Control Panel.  Double-click Add/Remove programs.  
Follow the instructions on your screen.   
Alternately, look for a file called install.exe or 
startup.exe on the installation disk or CD and run this 
directly by double-clicking it. 
 
 

PLACING SHORTCUT ON DESKTOP 
In My Computer or Windows Explorer, locate the item 
you want easy access to. Use the right mouse button 
to drag the item to the desktop.  Then release the 
mouse button.  Click Create Shortcut(s) Here.  The 
shortcut appears on your desktop.    You can put a 
shortcut in any folder, in addition to the one on the 
desktop.   When you delete a shortcut, the original file 
is not deleted.  If you delete the file, the shortcut is not 
deleted automatically. 
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SOFTWARE: 

WINDOWS EXPLORER 
(pre-installed with Windows 95 & 98) 

 

 
 

(taken from Introducing Windows 95 and Getting Started with Microsoft Windows 98) 
 

Opening Windows Explorer gives you a view of your computer's contents as a 
hierarchy, or "tree".  You can easily see the contents of each drive and folder on your 
computer, as well as any of the network drives you are connected to". 
 
To see the hierarchy of folders:   Click the Start button, point to Programs, and then 
click "Windows Explorer".   Your disk drives and folders appear on the left site.  To 
show or hide folders on the left side of the windows, click the plus or minus sign 
beside the folder.   The right side of the window displays the content so the item you 
click on the left. You can open a document or start a program by double-clicking its 
icon in the right side of the window.  
 

WINDOWS EXPLORER SHORTCUTS: 
• To Rename an Item   Press F2 
• To Find a Folder or File  Press F3 
• To Delete Immediately   Press SHIFT-DEL 
• To View Item Properties  Press ALT+ENTER 
• To Select All     Press CTRL+A 
• To Refresh a Window   Press F5 
• To View One Level Up   Press BACKSPACE 
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SOFTWARE: 
CALCULATOR 

(pre-installed with Windows 95 & 98) 
 

 
Standard Calculator 

 
To run the calculator, Click START -> Programs -> Accessories -> Calculator.   
 
You can use either your mouse to point at the buttons, or the number pad on the 
computer keyboard (or the numbers across the top of the QWERTY keys) 
 
There are two types of calculators available:  a standard calculator (default) and a 
scientific calculator (with trigonometric functions).  If you want to change the 
calculator from standard to scientific, choose "Scientific" from the view menu.  To close 
the calculator, click the X button (close button) in the upper right-hand corner. 
 
 

 
Scientific Calculator 
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SYSTEM SOFTWARE: 
CLOCK 

(pre-installed with Windows 95 & 98) 
 

 
 

To view the clock, double-click on the time in the lower right-hand portion of your 
screen.    To change the time, move the cursor to the number field (3:05:15 PM), insert 
the blinking icon between the numbers you wish to change, then click either the up or 
down arrow (alternately, you can type the number instead).   To change the day, click 
on the appropriate date. Likewise, to change the month or year, click the arrow to the 
left of each for a drag-down menu. 
 

 
 
For fun, double-check the time-zone by clicking the appropriate box under the 
"Date/Time Properties" header.  Check to see if you're in the proper time zone. 
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GRAPHICS SOFTWARE: 
PAINT 

(pre-installed with Windows 95 & 98) 
 

 
 

You can create, edit or view pictures by using Paint. You can paste pictures into other 
documents you've created, use them for your desktop background, view photos that 
you have scanned, and more.   Move the mouse pointer to the middle of the screen.  
Then drag (move the mouse while holding down the mouse's left button).  As you drag, 
you'll be drawing a squiggle.  When you draw, you're normally drawing in black. At the 
screen's bottom, you see additional colors.  To draw in one of these colors instead of 
black, click the color that you want. 
 
The buttons (in order) at the top of the screen are:

Free-Form Select 
Eraser 
Pick Color 
Pencil 
 
Airbrush 
Line 
Rectangle 
Ellipse 

Select 
Fill With Color 
Magnifier 
Brush 
 
Text 
Curve 
Polygon 
Rounded Rectangle 

 
May of these will cross over into other graphics programs.  The buttons I find most useful 
are: Eraser, Fill with Color, Pencil, Brush, and Text.  Everything else is nice, but not 
essential. 
 
To use a button, push it in by clicking it. When you start using Paint, the computer assumes 
you want to use the Pencil, so it pushes the Pencil button in.  If you want to use a different 
tool, click a different button instead.   
 
The computer pictures on Page 3 of this document were designed in Paint. 
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GRAPHICS SOFTWARE: 
MICROSOFT PHOTO EDITOR 

(packaged in Microsoft Office 97) 
 

 
 
This is a slightly more complex and very useful graphics program.  Most notable is its use of 
modifying pictures. 
 
To modify an existing image, select FILE-> Open and find the appropriate picture.  Once 
loaded, test out the properties under the IMAGE menu:   CROP (use the dotted line on the 
dashboard panel to select what section you want in a different picture), RESIZE (makes the 
picture larger or smaller), ROTATE (flips in any direction), BALANCE (changes the brightness 
and contrast) and AUTOBALANCE (my favorite - selects the best balance for the picture, 
given the colors) 
 
For further modification fun, select the EFFECTS menu:  SHARPEN (takes any hard line and 
reinforces it), SOFTEN (does the reverse), NEGATIVE (flips the colors), DESPECKLE (removes 
inconsistent bits of color), POSTERIZE (solidifies and reduces the colors on the palate), EDGE 
(super-emphasizes borders). 
 
Additional  features in EFFECTS that will alter the texture of the picture are:  CHALK & 
CHARCOAL, EMBOSS, GRAPHICS PEN, NOTEPAPER, WATERCOLOR, STAINED GLASS, 
STAMP and TEXTURIZER. 
 
When saving your modified image, it is standard to save photos as JPG  and graphic images 
(such as banners or buttons) as GIF. 
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TEXT-EDITING SOFTWARE: 
 

 
 
 

WORDPAD 
(pre-installed with Windows 95 & 98) 

 

 
 

Windows includes a new text editor that you can use to work on short documents.  Among 
its features are a toolbar for quick access to common tasks, a format bar with buttons for 
quickly formatting text, a full range of fonts for you to select from.    Not as sophisticated as 
Microsoft Word, but fancier than Notepad. 
 
The icons at the top of the menu (which will cross over into Microsoft Word) are:  

• New Document (icon resembles piece of paper) 
• Open Document (icon resembles manila folder) 
• Save File (icon resembles floppy disk) 
• Print File (icon sort of resembles printer) 
• Magnify Text (icon resembles magnifying glass and paper) 
• Cut (icon resembles scissors) 
• Copy (icon resembles two pages) 
• Paste (icon resembles clipboard) 
• Undo (icon resembles back arrow) 
• Insert Time/Date (icon resembles mini calendar and clock) 

 
One row down is  the font type: (Times New Roman), font size (10 points) and options to bold, 
italicize, underline or align page to the left, center or right or add bullet points to subjects 
(see list above). 
 
There is a ruler at the top of the page, and the cursor blinks in the section where you start 
typing. 

NOTEPAD 
(pre-installed with Windows 95 & 98) 

 
An extremely simple text-editing program 
included with Windows 95 & 98.   It 
allows you to create, edit and save simple 
text and is handy in that it doesn't take 
much memory to run. 
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TEXT-EDITING SOFTWARE: 
MICROSOFT WORD 

(packaged in Microsoft Office 97) 

 
 

When you start Microsoft Word, the screen contains a fresh document surrounded by a 
"dashboard" of handy buttons, menus and other tools that you can use to work on your 
document.   The blinking insertion point shows where the text you type will appear.   
 
For shortcuts to the more popular commands, click buttons on the Standard and Formatting 
toolbars.   Use the rulers to set tabs, indents and margins.  Use the mouse pointer to click 
buttons, select text, and so on (the pointer shape varies with the task you're doing).  Use the 
scroll bars to move around inside the document.   The status bar at the bottom shows details 
about your document, such as what page you're on. 
 

• To create a new document, click the New button 
• To insert today's date, click Date and Time (Insert menu) 
• To bring other parts of the document into view, use the scroll bars (to the right and 

bottom of the page). 
• To select any amount of text, drag over it.  To select a word, double-click it.  To select 

a line, click to the left of it.  To select multiple lines, click to the left of a line and drag 
up or down. 

 
The easiest way to move or copy text a short distance is drag-and-drop editing.  To move text, 
select the text, point to it, hold down the mouse button, drag the dotted pointer to the new 
location and then release the mouse button.   
 

HELPFUL TIPS: 
1. To set up your default document settings:  select FILE->PAGE SETUP.  Make sure the 

margins and paper source are exactly as you want them, as well as the font size and type.  
Hit the "Default" button on this page and all the rest of your documents will be in this 
format.  Very handy. 

 
2. To print labels in Microsoft Word:  have a document open first.  Select TOOLS -> 

ENVELOPE AND LABELS.  Double-check the size of the label and click "New Document".  
The new page will be aligned for your specific labels. 

 
3. Save your file in TXT format if you're planning on using another word processing 

program. Otherwise, use DOC (default setting) 
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SPEREADSHEET SOFTWARE: 

MICROSOFT EXCEL 
(packaged in Microsoft Office 97) 

 

 
 

Most of the work you do in MS Excel will be on a worksheet.  A worksheet is a grid of rows 
and columns.  Each cell is the intersection of a row and column and has a unique address, 
or reference.   For example, the cell where column B and row 4 intersect is cell B4.  You use 
cell references when you write formulas or refer to cells.   
 
Generally you first select the cell or cells you want to work with, and then you enter data or 
choose a command.  Selected cells appear highlighted on your screen.  The active cell is the 
cell in which data is entered when you start typing. Only one cell is active at a time. The 
active cell is shown by a heavy border.    
 
 
 

HELPFUL TIPS: 
 
• To add a column of numbers, click on the cell directly below the numbers and type 

=sum(A1:A3), where A1 is the starting cell and A3 is the ending cell.  Hit ENTER to view 
the results. 

• To add a row of numbers, click on the cell directly to the right of the numbers and type 
=sum(A1:F1), where A1 is the starting cell and F1 is the ending cell. Hit ENTER to view 
the results. 

• Take the average of a column by typing: =AVERAGE(A1:A4) 
• To fill a column with the same number, highlight the cells you want filled (including the 

starting number to fill) and hold down CTRL-D (for "Fill Down") 
• To sort a list of names, type CTRL-A (for "Select All") and choose DATA->SORT.  You can 

sort in increasing or decreasing order. 
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MISC: 
TIPS & TRICKS 

 
 

• The mouse and keyboard use virtually identical slots in the back of the computer.  If 
you've set up or moved your computer and are unable to use the  mouse or keyboard for 
the first time,  check to see if the cables are plugged into the right slots. 

 
• Hit "ESC" at the Windows 95 Startup screen if you want to see what sort of scripts are 

running on your computer (this screen will tell you whether all your drivers are loading or 
not). 

 
• Solitaire is an excellent way to become comfortable with using the mouse and is part of 

the Windows 95 and 98 CD-ROM for this very reason.  To play Solitaire on your 
computer, select  START -> PROGRAMS -> GAMES 

 
• If you still have the installation disks (i.e. Microsoft Windows 95, Microsoft Word, etc.), 

there's no need to back up your entire computer.  Back up only the files that you've 
created yourself (i.e. documents, spreadsheets, photos).   For ease of backup, keep all 
original material in one location (I use C:/My Documents/ with subfolders for individual 
breakdown). 

 
• Make a system startup disk  by clicking START ->SETTINGS -> CONTROL PANEL -> 

Add/Remove Hardware -> Startup Disk.  With a startup disk,  you should always be able 
to boot your computer to a C: prompt (this is useful if you're having problems starting 
your computer). 

 
• Keep a notebook by the computer and copy down discoveries and error messages 

verbatim.  These will often tell you exactly what is wrong with the computer (even if it's in 
a horribly garbled manner). 

 
• Run SCANDISK (checks your hard drive for errors) and DEFRAG (defragments your hard 

drive by putting all the individual programs memory in one location; speeds your 
computer up) by clicking START -> RUN and typing either SCANDISK or DEFRAG at the 
prompt. 

 
• If you have space on your hard drive, take the Windows 95 (or 98) CD-ROM and copy the 

/win95/ (or /win98/) file directly onto your hard drive.   Whenever you change any 
system settings and are prompted for the CD-ROM,  point to this folder on your hard 
drive instead (it contains all the system settings). 

 
• Suck mints or cough drops when dealing with especially irksome problems.  They'll take 

your mind off the computer. 
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ADDITIONAL RESOURCES: 

NYSL COMPUTER BOOKS
001.6 3  Berners-Lee, Tim  Weaving The Web       1999 
001.6 B Bradbeer, Robin  The Beginner's Guide To Computers   1982 
001.6 B Brod, Craig  Technostress      1984 
001.6 B Bear, John   Computer Wimp No More      1992 
001.6 B Branwyn, Gareth Mosaic Quick Tour For Windows    1994 
001.6 B Bryan, C. D. B.  Close Encounters Of The Fourth Kind  1995 
001.6 C Crichton, Michael  Electronic Life     1983 
001.6 C     Crevier, Daniel AI: The Tumultuous History Of The Search 1993 
001.6 C        Cyberspace: First Steps    1991 
001.6 C    Caffarelli, Fabrizio  Publishing Yourself On CD-ROM   1992 
001.6 C     Campbell-Kelly Computer: A History Of The Information 1996 
001.6 C    Casti, J. L.   The Cambridge Quintet     1998 
001.6 E     Elshami, Ahmed M  Networking Cdroms     1996 
001.6 F     Freedman, Alan The Computer Glossary    1991 
001.6 F    Freedman, David  Brainmakers      1994 
001.6 F    Freedman, Alan The Computer Desktop Encyclopedia  1996 
001.6 G     Gookin, Dan  PCs For Dummies     1992 
001.6 G     Gates, Bill   The Road Ahead     1995 
001.6 G     Gilster, Paul  The New Internet Navigator   1995 
001.6 G     Gelernter, David  Machine Beauty     1998 
001.6 H    Hammond, Ray  Computers And Your Child   1984  
001.6 H       Herbert, Frank Without Me You're Nothing   1980 
001.6 H  Herda, D. J.   Microcomputers     1984 
001.6 H     Hintz, Sandy  Computers In Our World    1984 
001.6 H     Hollerbach, Lew  A 60-Minute Guide To Microcomputers  1982 
001.6 H     Heim, Michael The Metaphysics Of Virtual Reality  1993 
001.6 H     Hahn, Harley  The Internet Complete Reference   1994 
001.6 H    Hafner, Katie. Where Wizards Stay Up Late    1996 
001.6 H     Holtzman, Steven R. Digital Mantras      1994 
001.6 J   Jortberg, Charles A.  The Internet     1997 
001.6 K     Kelly-Bootle, Stan The Devil's DP Dictionary    1981 
001.6 K    Kurzweil, Ray The Age Of Spiritual Machines   1999 
001.6 L     Levy, Steven  Artificial Life : The Quest For A New Creation 1992 
001.6 M     McCorduck, Pamela The Universal Machine    1985 
001.6 M    McWilliams, Peter The Personal Computer Book          1982 
001.6 M     Michie, Donald The Knowledge Machine    1985 
001.6 M     Mazlish, Bruce The Fourth Discontinuity    1993 
001.6 M     Morgan, Eric Lease WAIS And Gopher Servers    1994 
001.6 M     Moody, Fred  The Visionary Position    1999 
001.6 P     Penrose, Roger The Emperor's New Mind     1989 
001.6 P     Penrose, Roger Shadows Of The Mind    1994 
001.6 P     Peterson, Ivars Fatal Defect: Chasing Killer Computer Bugs 1995 
001.6 P Powell, Thomas A. HTML: The Complete Reference   1998 
001.6 R    Ritchie, David,  The Computer Pioneers     1986 
001.6 R     Roszak, Theodore  The Cult Of Information    1986 
001.6 S     Schank, Roger C. The Cognitive Computer     1984 
001.6 S     Shasha, Dennis  Out Of Their Minds     1995 
001.6 T     Turkle, Sherry The Second Self      1984 
001.6 W     Weizenbaum, J Computer Power And Human Reason   1976 
001.6 W     White, Ron  PC/Computing How Computers Work  1993 
001.6 W     Wiggins, Richard The Internet For Everyone  
001.6 Z     Zinsser, William K. Writing With A Word Processor   1983
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ADDITIONAL RESOURCES: 
BASIC COMPUTER TRAINING 

from The New York Public Library Site 
 

Baruch College, Continuing Education: 17 Lexington Ave, Box A 802-5600  
Fee? Yes  Offered: Day/Evenings 

Chinatown Manpower Project: 70 Mulberry Street, NYC 10013, 571-1697 
Fee? No  Offered: Day  

Correctional Educational Consortium: 500 8th Avenue, Suite 1207, 714-0600 
Fee? Yes  Offered: Day  

Global Business Institute: 209 West 125th Street, NYC 10027, 663-1500 
Fee? No  Offered: Day  

Henry Street Settlement: 301 Henry Street, NYC 10002, 254-3100 
Fee? No  Offered: Evening 

Jericho Project: 2013 Adam Clayton Powell, Jr.  Blvd., NYC 10027, 665-9444 
Fee? Yes  Offered: Day/Evening/W eekend 

The Learning Annex: 16 E. 53rd St., NYC 10022, 371-0280 
Fee? Yes  Offered: Day/Evenings  

Marymount Manhattan College, Continuing Education: 221 E. 71st St,  517-0564 
Fee? Yes  Offered: Day/Evening/Weekend  

New School:  66 W. 12th St., NYC 10016, 229-5630 
Fee? Yes  Offered: Day/Evening/Weekend 

New York City Mission Society: 646 Lenox Avenue,  10037, 212-368-8400 x21 
Fee? No  Offered: Day 

Non-Profit Computing, Inc. :40 Wall Street, Suite 2124, NYC 10005-1301, 759-2368 
Fee? No  Offered: Day  

NYC Board of Education, Office of  Continuing Education: (718) 260-2100  
Fee? No  Offered: Day/Evening/Weekend  

NYC Department of Administrative Services 2-26 Washington St, 10004, 487-5976 
Fee? No  Offered: Day  

NYU, School of Continuing Education: 7 E. 12th St, 11th Fl, (800) FIND NYU ext. 26 
Fee? Yes  Offered: Day/Evening/Weekend 

Pace University -Computer Learning Center: 551 5th Ave, 8th Fl,  10176, 346-1222 
Fee? Yes  Offered: Day  

PC Learn: 687-2506  
Fee? Yes  Offered: Day  

Post-Graduate Center for Mental Health: 344 West 36th Street 560-6720 
Fee? No  Offered: Day  

The Seminar Center: 655-0077  
Fee? Yes  Offered: Evening 

Stuyvesant Adult Center: 345 E. 15th Street, NYC 10003, 254-2890 
Fee? Yes  Offered: Evening 

Sys Ed: 35 W. 35th St., 10th Fl., NYC 10001, 564-9147, 48, 49 
Fee? Yes  Offered: Day/Evening/Weekend  

Train Central: 947-4210  
Fee? Yes  Offered: Evening 

Universal Business and Media School: 220 E. 106th St. (bet. 2nd & 3rd Aves.), NYC 
Fee? Yes  Offered: Evening 

Vocational Foundation, Inc.: 902 Broadway, 15th Floor, NYC 10010, 777-0700 
Fee? No  Offered: Day  

YWCA: 53rd & Lexington Ave., 5th Floor, NYC, 751-3335 
Fee? Yes Offered: Day/Evening

 


